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Introduction 
 

TerraWorld© is a Unity plugin to create close to reality environments using real-world data from ESRI, 

NASA & OpenStreetMap along with built-in algorithms for procedural generation and placement of 3D 

assets in scene. 

It’s a fully automatic level designer system working on top of a graph based system where users define 

settings in graph modules acting as connected nodes each handling specific operation to finally create or 

place assets on top of terrain in scene. 

The current system consists of various sections in order to handle all settings for world creation. The 

whole settings can be saved into a preset file which is easily shareable between TerraWorld© users. 

 

Features 
 

 Node-based user interface easily shareable between TerraWorld users 

 Creates detailed terrain surfaces using real-world elevation and satellite imagery 

 Heightmap filters such as Erosion and Terrace to generate realistic terrain surfaces  

 Outputs slope and flowmap masks from heightmap 

 Analyzing satellite images using filters such as “Color Filter” and use generated masks to create 

terrain layers used for terrain texturing 

 Outputs specific area features such as water, trees, grass and etc. from online landcover data 

and pass generated masks to “Mesh Generator” or “Scatter” nodes in order to create 3D models 

where needed and populate assets in scene. 

 Customized terrain shader which adds high-end features such as DX11 Tessellation, Height and 

Colormap Blending, Procedural Snow and Stochastic Texturing for terrain rendering. 

 Biome Templates which are pre-made graphs to cover various biome types in nature such as 

Forests, Grasslands, Deserts and Tundra environments. 

 Customized Standard Shader which supports Procedural Snow, Wind, Double Sided Rendering 

and Height-based Tessellation features. 

 Users can create new graphs or edit and customize existing ones to setup desired environment 

elements in scene. 

 Day Night cycle with automatic dynamic lighting adoption through the entire scene 

 Billboard Clouds Rendering with semi-volumetric representation 

 Atmospheric Scattering to cover Volumetric Lighting and Aerial Perspective Fog 

 Wind Simulation to support vertex animation in materials 

 Horizon Fog to fill in the gaps at scene horizon level and blend world bounds with sky 

 Procedural Snow coverage for the entire scene 

 Customized Water Shader with flowmapping support on surface 

 Compatible with Unity’s built-in Post Processing solution 



 Scatter objects and GPU Instances based on user-defined or analyzed environment elements 

such as slope, color, biome type and etc. in the scene with built-in high performance rendering. 

 Water area extraction from real-world landcover sources and automatic generation of lake and 

river surfaces. 

 Generated copies of terrain surface at specific areas based on user-defined rules or analyzed 

environment elements such as slope, color, biome type and etc. 

 Automatic Cache system to work in offline mode 

 Different Scene View modes to take the editor camera to specific hot spots. 

 Includes massive collection of hand-edited resources to start with creating desired landscapes. 

 In-Editor terrain preview before world generation. 

 

Getting Started 
 

These instructions will get you a copy of the project up and running on your local machine. 

Download provided unity package from TerraUnity’s webstore or Unity’s AssetStore and import into 

Unity. 

 

Prerequisites 
 

 Unity 2018.3 and up is required  

 

Installing 
 

When the package is imported in project for the first time, you need to do the following instructions to 

remove the errors and get TerraWorld running. 

1. From Unity’s menu go to Edit => Project Settings 

2. Go to Player settings 

3. Select “Other Settings” section 

4. Set Color Space to Linear 

5. Set Scripting Runtime Version to .Net 4.x 

6. Set API Compatibility Level to .Net 4.x 

7. Enable “Allow Unsafe Code” 

8. From Unity’s menu go to Window => Package Manager 

9. Find Post Processing Stack package from the list and install the latest version 

10. Load TerraWorld from Unity’s menu and go to Tools => TerraUnity => TerraWorld 



In order to load TerraWorld plugin, go to: 

Tools = > TerraUnity => TerraWorld 

 

In order to load Help file, go to: 

Tools = > TerraUnity => Help 

 

In order to access social links for TerraUnity, go to: 

Tools = > TerraUnity => Contact Us 

 

 

External Resources 
 

 Environment assets from Unity’s ” Book of the Dead” demo 

 Environment assets from Unity’s ” Fontainebleau” demo 

 Some Free stuff from the Unity AssetStore 

 TerraUnity Art Team’s terrain textures (copyrighted content) 

 TerraUnity’s custom graphics & rendering assets (copyrighted content) 

 
  



TerraWorld User Interface 

 

Tabs 
 
Users can select between available tabs to create or edit graphs 
and settings for world generation. 
 
The current system includes tabs of “Area”, “Heightmap”, 
“Colormap”, “Biomes”, “Terrain Rendering”, “VFX” & “Global 
Settings”. 

 
Area Selection 
This is where users define the area for world 
generation through a user-friendly interactive 2D map 
window. You can also toggle on a 3D preview map in 
scene to get an overview of the final environment. 

 
Heightmap 
This is the graph where users define heightmap and 
surface properties through various nodes of filters, 
masks and operators. The filters take input height data 
and process using realistic erosion, terrace and 
deformation filters and analyze surface to output slope, 
flow, curvature & aspect maps to be used by other 
nodes. 

 
Colormap 
All operations of satellite imagery analysis and terrain 
texturing is being done through this graph. The system 
uses advanced image processing algorithms to create a 
realistic colormap by analyzing satellite image pixels 
and surface analysis along with blending of detail 
textures based on obtained landcover. 

 
Biomes 
All environment elements which needs to be created or 
populated in the world can be handled through this 
graph. This graph includes specific biome extractors to 
detect landcover zones and use Scatter and MeshGen 
modules to place user-defined 3D models in scene and 
create procedural models where needed. 

 

 



Terrain Rendering 
 
This is where you define the type of terrain material 
and its features based on target platform. The Modern 
Rendering feature in this section uses TerraWorld©’s 
custom terrain shader which supports: 
 

 DX11 Tessellation & Phong Smoothing 

 Height Blending of detail textures for sharp 
looking texture blending 

 Colormap Blending for far/close blending of 
created colormap (derived from satellite image) 
with detail textures from camera position 

 Procedural Snow with full controls over 
strength, opacity and angle distribution 

 Procedural Puddles to scatter puddles along flat 
areas of terrain 

 Stochastic texturing to remove tiling artifacts 
due to high frequency details in textures 

 Per layer Material Properties of Color, AO 
(Ambient Occlusion), Metallic & Smoothness. 

 
 

VFX 
 
In this section we set all visual properties of the scene 
to define features such as day/night cycle, clouds 
rendering, atmospheric scattering, volumetric lighting 
and fog, season setup, real-time reflections and post 
processing. This gives users the ability to setup their 
desired mood and atmosphere in scenes. 

 
 

General Settings 
 
This section handles core general settings of the 
TerraWorld© system in order to toggle on/off specific 
features used in background operations and also UI. 

 



Footer 
 
Progress Bar: Loading progress for the generating world. 
Generate Button: Generates a world in the scene based on 
current graph. 
3D Button: Previews a 3D terrain in the center of the scene 
to give an overview of the generating world. 

 

 

 

 

 

 

 

 



Graph Generics 
 
3 tabs of “Heightmap”, “Colormap” & “Biomes” represent 
a graph-based UI which you add/remove/edit modules 
from the list of pre-built nodes each responsible for specific 
operation. 
 
TerraWorld© comes with node types of “Processor”, 
“Mask”, “Extractor”, “Scatter” & “TerraMesh”. 
 
Each node can be enabled/disabled without needing to be 
added or removed from the graph and also can be deleted 
from the graph. 

 

 



Clear Button 
 
Pressing the Clear button will clear all nodes in the current 
graph 

 

 



Add Nodes Section 
 
Processors are type of nodes which alter input data based 
on specific operation and output the same data type. 
 
From the “Add Processor” dropdown menu user can add a 
Processor node from the list. 

 
 
 
 

 

 

  

 



Node Settings Section 
 
All node settings will be displayed here for the users to set 
current node’s parameters. 
 
This section will be appeared by selecting a node on the 
graph. 

 
 

 

 



Area TAB 
 
This is where you define world location and area size along with 
selecting Biome type and  manage graphs to save/load 
customized graphs or load pre-made graphs that comes with 
TerraWorld©. 

 
 

 

 

 

 



 

 

 

 

 

Search Field 
 
Type in a location name or address anywhere on Earth. 
 
Pressing Search button will bring up a results window where 
you can set the center location for generating world. 

 

 



Search Results Window: When Search button is pressed, the search results window will pop up. 

 

 

List of query results with location names and point coordinates in Decimal Degrees (Left Image). 

Pin button to set center point of the world origin (Right Image). 

 

 



Interactive Map 
 
Pressing the Placemark button will open up a new window 
displaying an interactive map to select area of interest 
through a 2D map. 
 
The Interactive Map window will be loaded with latest used 
parameters. 

 

 

 

 



Interactive Map Window 

The Interactive Map is a dockable window which gives users the ability to navigate the entire Earth 

through a Satellite Image or LandCover style 2D map. 

 

 

 

 

Show HUD: Enable/Disable window UI controls 

Lock Area: Enabling this option will lock area bounds even if user changes map location 

Show Bounds: Turns the area selection graphic on or off 



Show Cross: Enable/Disable center cross graphic 

Map Styles 

Satellite: The base map preview style will be in aerial photo style 

Landcover: The base map preview style will be in OSM Landcover style (Following Image) 

 

 

 

 

 



Area Selection Mode 

World area in TerraWorld© is defined using 2 modes of “Center” & “BBox” 

Center: Set center point’s Latitude & Longitude coordinates in Decimal Degrees format and specify Width 

& Length of the area in kilometers. 

 

 

 

 



BBox: Insert arbitrary Top, Left, Bottom & Right coordinates in Decimal Degrees format to specify the 

area. 

 

 

 

 



Templates 
 
TerraWorld© includes some pre-designed graphs called 
templates. 
 
Users can select any of these templates as a base and make 
own changes. 
 
Note: Loading any of the Templates will overwrite all options 
except Area Selection and General Settings tab 

 

  



 

 

Graphs 
 
TerraWorld© is a graph-based system and users can create 
scenes from real-world data by defining node settings. 
 
User can select the graph preset from the pre-defined 
graphs built-in in TerraWorld© or create new ones from 
scratch along with saving or loading previously generated 
ones. 
 
New: 
Create and empty graph in TerraWorld© and then user can 
modify or design his/her own graph. 
 
Save:  
Saves current graph settings in UI into a file for later usage 
or world sharing between TerraWorld© users. 
 
Load: 
Loads previously generated graphs in TerraWorld©. 

 

 

 



HEIGHTMAP TAB 
 
Here you can add/remove/edit modules that operate on 
heightmaps to finally create terrain surface in world or use 
data in other nodes. 

 
 

 

  



HEIGHTMAP MASTER NODE 
 
Receives the last heightmap node in graph tree and applies to 
terrain surface. 

 
 
 

 

 

  



 

PROCESSORS 
 
Processors are type of nodes which alter input data based on 
specific operation and output the same data type.  
 
Example: “Smoothen Terrain” processor node in heightmap graph 
takes a processed heightmap from previous node and smoothen 
out the surface and then pass the result to the next node. 

 

Heightmap Source 
 
Provides the heighmap data for the selected area. 
 
Best Resolution: Automatically detects the best resolution from 
the data server and retrieves data from source. 
Resolution: If “Best Resolution” option is unchecked; users can 
define an arbitrary resolution value for the heightmap source. 

 

 
 

  



Smoothen Terrain 
 
Smoothen Terrain node, inputs heightmap to remove unwanted 
jagged edges and terraces on surface usually occurred by resample 
operation’s banding artifacts. 

 
Iterations: Number of iterations Smoothing operation will be 
applied on heightmap 
Blending: Blending between the new smoothed & old heightmap 
shape 
Type: Type of the Smooth operation 

 

 
 

 

 

 



Water Erosion 
 
“Water Erosion” node, simulate the water erosion effects on the 
input heightmap 
 
Iterations: Number of iterations that “Water Erosion Node” will be 
applied on heightmap 
Shape: Shape for the Water Erosion simulation 
Rivers: Rivers for the Water Erosion simulation 
Depth: Depth for the Water Erosion simulation 
Sea Bed: Sea-bed carving amount for the Water Erosion simulation 

 

 
 

 

 



Terrace Filter 
 
“Terrace Filter” will apply terrace simulation on the input 
heightmap 
 
Steps: Number of terrace steps on the surface 
Strength: Strength of the terrace effect on surface 
Variation: Position variation of the terrace steps in vertical axis 

 

 
 

 

 



Thermal Erosion 
 
“Thermal Erosion” node will apply thermal erosion simulation on 
the input heightmap 
 
Iterations: Number of iterations thermal erosion operation will be 
applied on heightmap 

 

 
 

 

 



Hydraulic Erosion 
 
Hydraulic Erosion occurs when the motion of water against a rock 
surface produces mechanical weathering. Most generally, it is the 
ability of moving water (flowing or waves) to dislodge and 
transport rock particles. 
 
TerraWorld© uses two different methods for simulating the 
Hydraulic Erosion on the terrain. 
 
 
Process Method - Ultimate: Hydraulic Erosion simulation on the 
input heightmap 
 

Iterations: Number of iterations Hydraulic Erosion 
operation will be applied on heightmap 

 
 
Process Method – Normal: Hydraulic Erosion simulation type 2 on 
the input heightmap 
 

Iterations: Number of iterations Hydraulic Erosion 
operation will be applied on heightmap 
Rain Amount: Rain amount for the Hydraulic Erosion 
simulation 
Sediment: Sediment strength for the Hydraulic Erosion 
simulation 
Evaporation: Evaporation strength for the Hydraulic 
Erosion simulation 

 

 
 

 



Terrain Deformer 
 
Terrain deformer takes a mask and deforms terrain surface based 
on input mask. 
 
Depth: Depth in meters to dig through the surface 
Flatten Floor: Flatten the floor of the deformed areas 

 



MASK 
 
Mask nodes will filter or mask work areas by defined filters. 

 

Flow Way Filter 
 
Creates a flow mask from the input heightmap which extracts 
rivers and water ways along the surface heights 
 
Iterations: Number of iterations flow way filter operation will be 
applied on heightmap  
Flow Range: Filter flow rate in normalized scope 

 

 
 

 

 



Slope Filter 
 
Creates a slope mask from the input heightmap which is 
normalized between 0 to 90 degrees in vertical axis 
 
Bounding Box: For selecting effective areas 
Slope Range: Minimum & maximum slope in degrees compared to 
horizon level for filtering area. 

 
 

 



Area Mixer 
 
Merges 2 area masks by logical operators. 

 
Blending Mode: Select blending mode to merge masks 

 
 

 

 

 

  

 

 



 

 

COLORMAP TAB 
 
All operations of satellite imagery analysis and terrain 
texturing is being done through this graph. 
 
The system uses advanced image processing 
algorithms to create a realistic colormap by analyzing 
satellite image pixels and surface analysis along with 
blending of detail textures based on obtained 
landcover. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 



COLORMAP MASTER NODE 
 
This node takes all terrain global layer nodes and merge them as 
the terrain colormap. 
 
Colormap is a global image which covers the whole area which is 
useful for far viewing distances and because of its limitation 
(especially in image resolution) usually used for low level details. 
 
TerraWorld© can use processed image base on real world satellite 
image as a colormap and blend it with user defined “Detail 
Textures”. Camera will render the satellite image as a cover image 
- if it has a “far distance look” at terrain - and will smoothly replace 
the ”Detailed Textures” while camera is getting close to the 
surface. 
 
Note: In Legacy Terrain Rendering mode, the colormap master 
node will be applied on the RED channel of splat map as the first 
terrain layer. 

 

 

  

 



TERRAIN LAYERS MASTER NODE 
 
Takes a terrain detail layer node and applies it as terrain layer for 
detailed texturing on splat map channels. 
 
Terrain layers are high resolution textures used for detail texturing 
and are useful for near viewing distances. Because of the high 
resolution, they are used for ground level details but on the other 
hand they can use a huge amount of system resources. 
 
TerraWorld© can use processed image base on real world satellite 
image as a colormap and blend it with user defined “Detail 
Textures”. Camera will render the satellite image as a cover image 
- if it has a “far distance look” at terrain - and will smoothly replace 
the” Detailed Textures” while camera is getting close to the 
surface. 
 
TerraWorld© is limited to four detail texture layers in “High-End” 
rendering mode but there is no limitation for “Legacy” rendering 
mode in terrain layers. 
 
Note: in Legacy Terrain Rendering mode, Colormap Blending is not 
supported. 
 
Note: Each terrain layer will be applied on a different splatmap 
channel. 

 

 

  

 

 

 



PROCESSORS 
 
Processors are type of nodes which alter input data based on 
specific operation and output the same data type. 
 
Example: “Smoothen Terrain” processor node in heightmap graph 
takes a processed heightmap from previous node and smoothen 
out the surface and then pass the result to the next node. 

 

Satellite Image 
 
Provides the satellite image of the selected area. 
 
Source: Select imagery source from various mapping providers 
Resolution: Select satellite image resolution for the entire world 

 

 

 

  

 

 



Terrain Global Layer 
 
Takes an image and an input mask to filter out pixels and add up 
to the final colormap. 
 
Terrain global node uses 3 methods to process and prepare an 
image to bake it on the final colormap 
 

 BAKE IMAGE: This method cuts out the selected area and bakes 

it to final colormap. 
 

 BAKE SIMPLIFIED IMAGE: This method will extract the most 

used color in selected area and then simplifies the image by 
detected colors. 
 

Color Count: Simplify image to most used colors 
Fill Color: Fill masked area with this color on colormap 

 
 FILL AREA WITH COLOR: This method will fill the masked areas 

by selected color and bakes it to the final colormap 

 

 

 

  

 

 



Terrain Detail Layer 
 
Creates a detail texture layer in terrain data for splatmap texturing. 
 
This node takes a mask (e.g. Slope range from heightmap graph) as 
input and creates splat layer based on the mask. Splat areas will be 
filled with the inserted terrain layer asset. 
 
Opacity: Opacity of the terrain layer 
 
In TerraWorld©, users can assign a terrain layer (Detail Texture 
Layer) by using the 2 following methods: 
 

 Using existing terrain layer 
Terrain Layer: Select Terrain Layer for rendering 

 

 Creating new terrain layer 
Diffuse Map: Diffuse texture for the layer 
Normal Map: Normalmap texture for the layer 
Normal Strength: Normal map strength on the 
surface 
Mask Map: Mask map texture for the layer 
Tiling: Tiling for the inserted texture on material 
Offset: Tiling Offset for the inserted texture on 
material 
Specular: Specular color on the surface 
Metallic: Metallic strength on the surface 
Smoothness: Smoothness strength on the surface 

 

 

  

 

 

 



MASK 
Mask nodes will filter or mask work areas by defined filters. 

 

Color Filter 
 
Takes an external image/texture asset and generates mask based 
on user-defined color in the image pixels. 
 
Selected Color: A mask will be generated for the system using the 
selected color 
Tolerance: Tolerance range for the selected color in color space 
External Image: Use external source image instead of the input 
node's image 

 

 

  

 

 

 

 



Area Mixer 
 

Blends 2 masks with each other based on selected logical 
operator 
 
Blending Mode: Select mode to blend masks. 
 
Logical Operators: 

 

 

  

 

 

 

 

 



BIOMES TAB 
 
In Biomes graph, user can do following actions: 
 

 Filtering area based on biomes and land cover data 

 Scatter objects & GPU instances on the terrain 

 Generate lakes & rivers 

 Generate a copy of terrain surface at specific locations or 
specific rules 

 

 

 

  

 

 

 



MASK 
 
Masks nodes will filter or mask work areas by defined filters. 
 

Biome Filter 
 
Connects to Landcover data source and outputs biome feature 
areas. 
 
Bounding Box: Defining active area 
Source: Select Elevation source from various mapping providers 
Rivers Width (M): Default rivers’ width in meters (M) 
Borders Only: Extract only edges of the detected masked area 
Edge Size (M): Area damping along the borders in meters 
Scale: Scale of the whole shape of the mask 
MIN. Area (M2): Ignore areas with less than specified Min. size in 
square meters (M2) 

 

 

  

 

 



Area Mixer 
 
Blends 2 masks with each other based on selected logical operator 
 
Blending Mode: Select mode to blend masks. 
 
Logical Operators: 

 



SCATTER 
 
Scatters inserted models in the scene based on various placement 
settings. 
 
Terrain Tree Scatter 
 
Scatters vegetation models in the scene based on various 
placement settings and applies them to the terrain data. 

 
Bounding Box: Defining active area 
Prefab: Prefab used for the tree model 
Seed#: Seed number for unique procedural values 
KM2 Density: Instance count per square kilometer for placement 
90° Rotation: Rotation is only performed in 90 degree multiplies 
0°, 90°, 180° & 270° 
Horizontal Rotation: Rotation is locked in horizontal rotation axis 
(Y) only 
Rotation Range: Minimum & Maximum rotation in degrees for 
object 
Random Position: Percentage of the random position for instance 
Scale Multiplier: The multiplier value for the original object scale 
Scale Range: Minimum & Maximum random scale variation 
Slope Range: Minimum & Maximum slope in degrees compared 
to horizon level for object placement 
Offset: Placement offset of the object in 3 dimensions 
Layer Name: Parent Layer name of the current object's layer in 
hierarchy view 
Layer Mask: Object placement will be applied on selected layer(s) 
 
Note : Terrain Tree Scatter node uses Unity’s standard Terrain Tree 
system for scattering objects & instances 

 



Object Scatter 
 
Scatters game objects in the scene based on various placement 
settings. Object scatter is designed to scatter prefabs in scene. 
 

Bounding Box: Defining active area 
Placement on water: Object scatter can ignore water 
surfaces or place above or below water surfaces 
Seed#: Seed number for unique procedural values 
KM2 Density: Instance count per square kilometer for 
placement 
90° Rotation: Rotation is only performed in 90 degree 
multiplies 0°, 90°, 180° & 270° 
Horizontal Rotation: Rotation is locked in horizontal rotation 
axis (Y) only 
Rotation Range: Minimum & Maximum rotation in degrees 
for object 
Random Position: Percentage of the random position for 
instance 
Scale Multiplier: The multiplier value for the original object 
scale 
Scale Range: Minimum & Maximum random scale variation 
Slope Range: Minimum & Maximum slope in degrees 
compared to horizon level for object placement 
Offset: Placement offset of the object in 3 dimensions 
Layer Name: Parent Layer name of the current object's layer 
in hierarchy view 
Unity Layer: Select object's Unity layer 
Layer Mask: Object placement will be applied on selected 
layer(s) 
 

 



Instance Scatter 
 
Scatters GPU instances in the scene based on various placement 
settings. Instances do not have collider and do not support physics, 
but they are very light in rendering and millions of instances can 
be placed in a scene. 
 
 
Bounding Box: For selecting effective areas 
Prefab: Prefab used for GPU instance object 
Shadow Casting: Shadow Casting mode for each instance 
Shadow Receiving: Receive shadows on model or not? 
Seed: Seed number for unique procedural values 
Placement Distance (M): Placement distance in meters between 
instances  
Instance Count: Instance count for each patch 
90° Rotation: Rotation is only performed in 90 degree multiplies 
0°, 90°, 180° & 270° 
Horizontal Rotation: Rotation is locked in horizontal rotation axis 
(Y) only 
Surface Rotation: Rotation is calculated from the underlying 
surface angle 
Rotation Range: Minimum & Maximum rotation in degrees for 
object 
Random Position: Percentage of the random position for instance 
Scale: Original scale of the instance  
Scale Range: Minimum & Maximum random scale variation 
Slope Range: Minimum & Maximum slope in degrees compared 
to horizon level for object placement 
Position Offset: Placement offset of the object in 3 dimensions 
Rotation Offset: Rotation offset of the object in 3 dimensions 
Layer Name: Parent Layer name of the current object's layer in 
hierarchy view 
Unity Layer: Select object's Unity layer 
Layer Mask: Object placement will be applied on selected layer(s) 
 

 

 



TERRAMESH 
 
Generates 3D Mesh for lakes, rivers and terrain surfaces in filtered 
areas. 
 

Water Generator  
 
Generates lake and water surfaces in the area 
 

 
Generate Lakes: Generate lakes in the world 
MIN. Area (M2): Bypass generation of lakes with specified 
minimum area size in square meters (M2) 
Generate Rivers: Generate rivers in the world 
River Width (M): Set default width for rivers in meters 
River/Lake Depth (m): Set default depth for rivers/lakes in meters 
Material: Material used for this object 
LOD Culling: Minimum object's screen size percentage where it 
culls from rendering 
Offset: Placement offset of the object in 3 dimensions 
Layer Name: Layer name of the current object's layer 

 
 

 

 

  

 

 

 



Mesh Generator 
 
Generates a copy of terrain surface based on user-defined rules. 
 

Material: Material used for this object 
LOD Culling: Object's screen size percentage where it culls 
from rendering 
Collider: Does object contribute to collision detection! 
Physics: Enable or disable Rigidbody component on the 
object to perform physics calculations 
Continuous Surface: Generate mesh as a single object 
Grid Count: Divide surface into a grid of mesh chunks 
Resolution (M): Distance between mesh vertices in meters 
MAX Vertex Count (x1000): Maximum vertex count value 
multiplied by 1000 which is allowed for each mesh grid 
Edge Curve (M): Curve amount along the edges of the mesh 
vertices in meters 
Scale: Original scale of the object 
Offset: Placement offset of the object in 3 dimensions 
Layer Name: Layer name of the current object's layer 
Unity Layer: Select object's Unity layer 
 
 

 

 

  

 

 

 



Terrain Rendering TAB 
 
In this tab users define all settings related to terrain material. 
 
If user is on Unity’s Standard Rendering Pipeline, “High-End” 
terrain rendering will be activated for advanced terrain shader 
features. 
 
Note: TerraWorld’s custom terrain shader is not supported on 
SRPs such as HDRP & URP (aka LWRP) yet. 

 

 

  

 

 

 



Terrain Rendering Mode 
 
Select between High-End & Legacy (Unity’s built-in Standard 
terrain shader). 
 
When High-End mode is selected, TerraWorld’s custom terrain 
shader will be assigned to the terrain and advanced features will 
be unlocked for terrain rendering. 

 

 

  

 

 

 

 



Tessellation 
 
Activate DX11 Tessellation on surface 

 
Quality: Tessellation quality on surface 
Edge Smoothness: Phong smoothness on surface edges 
 

 

 

  

 

 

 



Heightmap Blending 
 
Activate Heightmap Blending on surface 

 
Height Blending: Heightmap Blending range between terrain layers 
 

 

 

  

 

 

 



Colormap Blending 
 
Activate Colormap Blending on surface 
 
Distance: Blending distance between Colormap & detail textures 
Global Power: Global blending power between Colormap & detail 
textures 
 

 

 

  

 

 

 



Procedural Snow 
 
Activate Procedural Snow on surface 
 
Snow Color: Snow color on terrain surface 
Tiling: Texture tiling for snow rendering 
Amount: Amount value for snow rendering 
Angles: Angles distribution for snow rendering 
Normal Influence: Detail textures normalmap influence for snow 
rendering 
Power: Power value for snow rendering 
Smoothness: Smoothness value for snow rendering 

 
 

 

 

  

 

 

 

 



Terrain Layers 
 
Terrain Data’s terrain layers as detail textures 
 
Terrain Layer: Reference to the TerrainLayer asset 
Displacement: Tessellation displacement taken from layer 
heightmap on surface 
Height Offset: Layer height offset on surface 
Tiling Remover: Tiling Remover intensity 
Tiling Noise: Tiling Remover noise 
Color: Layer color on terrain surface 
AO: Ambient Occlusion value for texture layer rendering 
 

 

 

  

 

 

 

 



VFX TAB 
 
In this section users set all visual properties of the scene to define 
features such as day/night cycle, clouds rendering, atmospheric 
scattering, volumetric lighting and fog, season setup, real-time 
reflections and post processing. This gives users the ability to setup 
their desired mood and atmosphere in scenes. 
 
User can turn on/off VFX to achieve high-end graphics! 
 

 

 

  

 

 

 

 

 



Day Night Cycle 
 
Set time of day settings. 
 
Manual / Auto: Switch on or off day/night cycle 
Sun Elevation: Elevation of the Sun in the world 
Azimuth: Azimuth of the Sun in the world 
Global Speed: Global speed for the day/night cycle 

 
 

 

 

  

 

 

 

 

 



Clouds 
 
Switch clouds on or off  

 
Altitude: Clouds altitude in the 3D space 
Density: Density of the clouds in the area 
Size: Size of cloud instances 
Seed No.: Seed No. for the clouds randomization 
Emit Probability (%): The percentage of snow/rain emit probability 
from the clouds 
Shadows: Turn on/off clouds shadow casting! 
 

 

 

 

  

 

 

 

 

 



Atmospheric Scattering 
 
Switch atmospheric scattering on or off  
 
Note: Atmospheric scattering is only enabled when there are 4 
shadow cascades enabled! 
 
Light Intensity: Volumetric light intensity 
Aerial Fog Intensity: Atmospheric aerial fog intensity 
Aerial Fog Density: Atmospheric aerial fog density 
Aerial Fog Distance: Atmospheric aerial fog distance 
 

 

 

  

 

 

 

 

 



Wind 
 
Switch wind simulation on or off  
 
Wind Speed: Wind Speed for the volumetric fog 
 

 

 

  

 

 

 

 

 

 



Horizon Fog 
 
Switch Horizon Fog on or off 
 
Density: Horizon Fog Density 
Height Range (M): Minimum & Maximum starting height of 
horizon fog 

 

 

  

 

 

 

 

 

 



Snow 
 
Toggle Snow rendering in scene 
 
Height Range(M): Minimum & Maximum starting height of snow 
in meters 
Change Speed: Speed of weather change 
Start Height: Staring height of the snow on surface 
Height Falloff: Height Falloff for the starting point of the snow on 
surface 
 

 

 

  

 

 

 

 

 

 



Water 
 
Water rendering settings 
 
Quality: Quality of water rendering and features 
Base Color: Base water color 
Planar Reflection: Switch planar reflection to simulate real-time 
reflections on surface 
Reflection Quality (0~1): Quality of the reflection on water surface 
Reflection Color: Reflection color and depth on water surface 
Edge Blend: Blending of water surface at the edges to simulate 
foam and transparency at the edges 
Sun Specular: Simulate sun specular lighting on surface 
Gerstner Waves: Switch Gerstner waves on water surface which 
displaces water mesh vertices to simulate waves 

 
 

 

 

  

 

 

 

 

 

 



Post Processing  
 
The post processing stack comes with a collection of effects and 
image filters you can apply to your cameras to improve the visuals 
of your games. 
 

Edit Post Processing: Edit post processing settings. Pressing this 
button will take you to the Post Processing asset file in order to 
edit and customize settings. 

 
 

 

 

  

 

 

 

 

 

 



Advanced Settings 
 
Reset to default settings or edit all runtime VFX parameters living 
in scene hierarchy.  

 
 
 

 

 

  

 

 

 

 

 



Global Settings TAB 
 
Here you can define global settings which will be shared between 
all graphs and TerraWorld system.  

 
 
 

 

 

  

 

 

 

 

 



World Creation Mode 
 
Select between New or Replace world modes. When in Replace 
mode, the existing world in scene will be destroyed and the new 
one will be replaced. 

 
 

 

 

  

 

 

 

 

 



Data Cache 
 
Data cache option will enable/disable cache system for data 
fetching from internet. 

 
 

 

 

  

 

 

 

 

 



Preview Quality 
 
The preview quality defines resolution of preview system requests 
both in UI and scene previews. 
 
Resolution: Resolution for preview requests in scene and UI 

 
 

 

 

  

 

 

 

 

 

 



Splatmaps 
 
Splatmap settings used on terrains for texturing  
 
Best Fit: Automatically calculate splatmap resolution 
Smoothness: Smoothness iterations for the splatmap channels 
blending 
 

 

 

 

  

 

 

 

 

 

 



Terrain 
 
Terrain surface quality applied on heightmap. 
 
Pixel Error: Pixel Error value for the main terrain's surface quality 
 

 

 

  

 

 

 

 

 



Background Terrain 
 
Background Terrain Settings. 
 
Area Multiplier: Background Terrain's area size is value multiplied 
with the original world size. 
Heightmap Resolution: Select heightmap resolution for the 
background world 
Image Resolution: Select satellite image resolution for the 
background world 
Pixel Error: Pixel Error factor for the background terrain surface 
quality 
Y Offset: Offset in meters for the background terrain's Y position 
Snow Cover: Enable or disable snow cover on background terrain 

 

 

  

 

 

 

 

 



Scene View 
 
Turn on/off Scene View UI display displaying TerraWorld© related 
information in scene view. 

 

 

  

 

 

 

 

 



Debug Log 
 
Logs all generation steps into the console window. 
 

 

 

  

 

 

 

 

 

 


